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Chapter 375

Ratio of Polynomials
Fit – One Variable
Introduction
This program fits a model that is the ratio of two polynomials of up to fifth order. Examples of this type of model
are:

Y=

A0 + A1 X + A2 X 2
1 + B1 X + B2 X 2

and

Y=

A0 + A1 X + A2 X 2 + A3 X 3 + A4 X 4 + A5 X 5
1 + B1 X + B2 X 2 + B3 X 3 + B4 X 4 + B5 X 5

These models approximate many different curves. They offer a much wider variety of curves than the usual
polynomial models. Since these are approximating curves and have no physical interpretation, care must be taken
outside the range of the data. You must study the resulting model graphically to determine that the model behaves
properly between data points.
Usually you would use the Ratio of Polynomials Search procedure first to find an appropriate model and then fit
that model with this program.

Starting Values
Starting values are determined by the program. You do not have to supply starting values.

Assumptions and Limitations
Usually, nonlinear regression is used to estimate the parameters in a nonlinear model without performing
hypothesis tests. In this case, the usual assumption about the normality of the residuals is not needed. Instead, the
main assumption needed is that the data may be well represented by the model.

Data Structure
The data are entered in two variables: one dependent variable and one independent variable.
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Missing Values
Rows with missing values in the variables being analyzed are ignored in the calculations. When only the value of the
dependent variable is missing, predicted values are generated.

Procedure Options
This section describes the options available in this procedure.

Variables Tab
This panel specifies the variables used in the analysis.

Variables
Y (Dependent) Variable
Specifies a single dependent (Y) variable from the current database.
Y Transformation
Specifies a power transformation of the dependent variable. Available transformations are
Y’=1/(Y*Y), Y’=1/Y, Y’=1/SQRT(Y), Y’=LN(Y), Y’=SQRT(Y), Y’=Y (none), and Y’=Y*Y
X (Independent) Variable
Specifies a single independent (X) variable from the current database.
X Transformation
Specifies a power transformation of the independent variable. Available transformations are
X’=1/(X*X), X’=1/X, X’=1/SQRT(X), X’=LN(X), X’=SQRT(X), X’=X (none), and X’=X*X

Model
Bias Correction
This option controls whether a bias-correction factor is applied when the dependent variable has been
transformed. Check it to correct the predicted values for the transformation bias. Uncheck it to leave the predicted
values unchanged. See the Introduction to Curve Fitting chapter for a discussion of the amount of bias and the
bias correction procedures used.
These options specify the polynomials as well as certain values used to control the convergence of the nonlinear
fitting algorithm.

Model – Numerator and Denominator Terms
Numerator and Denominator Terms (A1 X^1 ... B5 X^5)
These options specify which terms are in the model. The A-terms refer to the numerator and the B-terms refer to
the denominator. Note that X^3 means X*X*X (X cubed).
Hence, checking A1 X^1, A2 X^2, B1 X^1, and B2 X^2 specifies the polynomial ratio model:

Y=

A0 + A1 X + A2 X 2
1 + B1 X + B2 X 2
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Note that the constant term, A0, is always included in the model.
We encourage you to follow a hierarchical approach to model building which is that you never fit a term without
fitting all terms of lesser order. Hence, if you include A3 in your model, you also include A1 and A2. Also, never
fit a higher order in the numerator than in the denominator. You can fit a higher order polynomial in the
denominator than in the numerator.
If you follow these simple rules, you will usually be happy with the performance of your models.

Options Tab
The following options control the nonlinear regression algorithm.

Options
Lambda
This is the starting value of the lambda parameter as defined in Marquardt’s procedure. We recommend that you
do not change this value unless you are very familiar with both your model and the Marquardt nonlinear
regression procedure. Changing this value will influence the speed at which the algorithm converges.
Nash Phi
Nash supplies a factor he calls phi for modifying lambda. When the residual sum of squares is large, increasing
this value may speed convergence.
Lambda Inc
This is a factor used for increasing lambda when necessary. It influences the rate at which the algorithm
converges.
Lambda Dec
This is a factor used for decreasing lambda when necessary. It also influences the rate at which the algorithm
converges.
Max Iterations
This sets the maximum number of iterations before the program aborts. If the starting values you have supplied
are not appropriate or the model does not fit the data, the algorithm may diverge. Setting this value to an
appropriate number (say 50) causes the algorithm to abort after this many iterations.
Zero
This is the value used as zero by the nonlinear algorithm. Because of rounding error, values lower than this value
are reset to zero. If unexpected results are obtained, you might try using a smaller value, such as 1E-16. Note that
1E-5 is an abbreviation for the number 0.00001.

Reports Tab
The following options control which reports and plots are displayed.

Select Reports
Iteration Report ... Residual Report
These options specify which reports are displayed.
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Report Options
Alpha Level
The value of alpha for the asymptotic confidence limits of the parameter estimates and predicted values. Usually,
this number will range from 0.1 to 0.001. A common choice for alpha is 0.05, but this value is a legacy from the
age before computers when only printed tables were available. You should determine a value appropriate for your
needs.
Precision
Specify the precision of numbers in the report. Single precision will display seven-place accuracy, while the
double precision will display thirteen-place accuracy. Note that all reports are formatted for single precision only.
Variable Names
Specify whether to use variable names or (the longer) variable labels in report headings.

Plots Tab
This section controls the plot(s) showing the data with the fitted function line as well as the residual plots.

Select Plots
Function Plot with Actual Y ... Probability Plot with Transformed Y
These options specify which plots are displayed. Click the plot format button to change the plot settings.

Storage Tab
The predicted values and residuals may be stored to the current dataset for further analysis. This group of options
lets you designate which statistics (if any) should be stored and which variables should receive these statistics.
The selected statistics are automatically stored to the current dataset while the program is executing.
Note that existing data is replaced. Be careful that you do not specify columns that contain important data.

Storage Columns
Store Predicted Values, Residuals, Lower Prediction Limit, and Upper Prediction Limit
The predicted (Yhat) values, residuals (Y-Yhat), lower 100(1-alpha) prediction limits, and upper 100(1-alpha)
prediction limits may be stored in the columns specified here.
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Example 1 – Fitting a Ratio of Polynomials Model
This section presents an example of how to fit a ratio of polynomials model. In this example, we will fit a third
order polynomial in the numerator and a fourth order polynomial in the denominator to the variables Y and X of
the FnReg3 database.
You may follow along here by making the appropriate entries or load the completed template Example 1 by
clicking on Open Example Template from the File menu of the Ratio of Polynomials Fit – One Variable window.
1

Open the FnReg3 dataset.
•
From the File menu of the NCSS Data window, select Open Example Data.
•
Click on the file FnReg3.NCSS.
•
Click Open.

2

Open the Ratio of Polynomials Fit – One Variable window.
•
Using the Analysis menu or the Procedure Navigator, find and select the Ratio of Polynomials Fit – One
Variable procedure.
•
On the menus, select File, then New Template. This will fill the procedure with the default template.

3

Specify the variables.
•
On the Ratio of Polynomials Fit – One Variable window, select the Variables tab.
•
Double-click in the Y (Dependent) Variable box. This will bring up the variable selection window.
•
Select Y from the list of variables and then click Ok.
•
Double-click in the X (Independent) Variable box. This will bring up the variable selection window.
•
Select X from the list of variables and then click Ok.
•
Under the Numerator Terms heading, check A1 X^1, A2 X^2, and A3 X^3.
•
Under the Denominator Terms heading, check B1 X^1, B2 X^2, B3 X^3, and B4 X^4.

4

Specify the options.
•
On the Ratio of Polynomials Fit – One Variable window, select the Options tab.
•
Enter 10 in the Max Iterations box.

5

Specify the reports.
•
On the Ratio of Polynomials Fit – One Variable window, select the Reports tab.
•
Check the Residual Report box. Leave all other reports and plots checked.

6

Run the procedure.
•
From the Run menu, select Run Procedure. Alternatively, just click the green Run button.
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Minimization Phase Section
Minimization Phase Section
Itn
Error Sum
No. Lambda
Lambda
A0
0
70.81162 0.00004
11.78766
1
70.73225 0.16
11.78725
2
70.68134 0.064
11.78944
3
70.61962 0.256
11.78874
4
70.58868 0.1024
11.78977
5
70.58413 0.4096
11.78925
6
70.5548
0.16384
11.78946
7
70.54813 0.065536
11.79198
8
70.51613 0.262144
11.7916
9
70.50236 0.1048576
11.79268
10
70.49983 0.4194304
11.79228
Maximum iterations before convergence.

A1
-0.2798519
-0.2798166
-0.2797599
-0.2797441
-0.2797041
-0.2796919
-0.2796662
-0.2796135
-0.2795997
-0.2795659
-0.279557

A2
5.809555E-03
5.810308E-03
5.810308E-03
5.810308E-03
5.810308E-03
5.810308E-03
5.810308E-03
5.810308E-03
5.810308E-03
5.810308E-03
5.810308E-03

A3
-4.172031E-05
-4.172031E-05
-4.172031E-05
-4.172031E-05
-4.172031E-05
-4.172031E-05
-4.172031E-05
-4.172031E-05
-4.172031E-05
-4.172031E-05
-4.172031E-05

This report displays the error (residual) sum of squares, lambda, and parameter estimates for each iteration. It
allows you to observe the algorithm’s progress.

Model Estimation Section
Model Estimation Section
Parameter
Name
A0
A1
A2
A3
B1
B2
B3
B4

Parameter
Estimate
11.79254
-0.2795364
5.810308E-03
-4.172031E-05
-0.0783304
2.391857E-03
-2.86472E-05
1.171313E-07

Asymptotic
Standard Error
1.012715
9.166186E-02
3.516727E-03
2.863182E-05
2.020337E-03
4.689093E-05
4.332001E-06
1.025966E-06

Lower
95% C.L.
9.750206
-0.4643901
-1.281847E-03
-9.946187E-05
-8.240479E-02
2.297292E-03
-3.738351E-05
-1.951927E-06

Upper
95% C.L.
13.83488
-9.468261E-02
1.290246E-02
1.602125E-05
-0.074256
2.486421E-03
-1.991088E-05
2.186189E-06

Dependent
Y
Independent
X
Model
Y=(A0+A1X^1+A2X^2+A3X^3) / (1+B1X^1+B2X^2+B3X^3+B4X^4)
R-Squared
0.990159
Iterations
10
Estimated Model
((11.79254-(.2795364)*(X)+(5.810308E-03)*(X)^2-(4.172031E-05)*(X)^3)/(1-(.0783304)*(X)+(2.391857E-03)*
(X)^2-(2.86472E-05)*(X)^3+(1.171313E-07)*(X)^4))

Parameter Name
The name of the parameter whose results are shown on this line.
Parameter Estimate
The estimated value of this parameter.
Asymptotic Standard Error
An estimate of the standard error of the parameter based on asymptotic (large sample) results.
Lower 95% C.L.
The lower value of a 95% confidence limit for this parameter. This is a large sample (at least 25 observations for
each parameter) confidence limit.
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Upper 95% C.L.
The upper value of a 95% confidence limit for this parameter. This is a large sample (at least 25 observations for
each parameter) confidence limit.
Model
The model that was estimated. Use this to double check that the model estimated was what you wanted.
R-Squared
There is no direct R-Squared defined for nonlinear regression. This is a pseudo R-Squared constructed to
approximate the usual R-Squared value used in multiple regression. We use the following generalization of the
usual R-Squared formula:
R-Squared = (ModelSS - MeanSS)/(TotalSS-MeanSS)
where MeanSS is the sum of squares due to the mean, ModelSS is the sum of squares due to the model, and
TotalSS is the total (uncorrected) sum of squares of Y (the dependent variable).
This version of R-Squared tells you how well the model performs after removing the influence of the mean of Y.
Since many nonlinear models do not explicitly include a parameter for the mean of Y, this R-Squared may be
negative (in which case we set it to zero) or difficult to interpret. However, if you think of it as a direct extension
of the R-Squared that you use in multiple regression, it will serve well for comparative purposes.
Iterations
The number of iterations that were completed before the nonlinear algorithm terminated. If the number of
iterations is equal to the Maximum Iterations that you set, the algorithm did not converge, but was aborted.
Estimated Model
The model that was estimated with the parameters replaced with their estimated values. This expression may be
copied and pasted as a variable transformation in the spreadsheet. This will allow you to predict for additional
values of X.

Analysis of Variance Table
Analysis of Variance Table
Source
Mean
Model
Model (Adjusted)
Error
Total (Adjusted)
Total

DF
1
8
7
43
50
51

Sum of
Squares
76141.53
83234.82
7093.291
70.49983
7163.791
83305.32

Mean
Square
76141.53
10404.35
1013.327
1.639531

Source
The labels of the various sources of variation.
DF
The degrees of freedom.
Sum of Squares
The sum of squares associated with this term. Note that these sums of squares are based on Y, the dependent
variable. Individual terms are defined as follows:
Mean

The sum of squares associated with the mean of Y. This may or may not be a part of
the model. It is presented since it is the amount used to adjust the other sums of
squares.
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Model

The sum of squares associated with the model.

Model (Adjusted)

The model sum of squares minus the mean sum of squares.

Error

The sum of the squared residuals. This is often called the sum of squares error or just
“SSE.”

Total

The sum of the squared Y values.

Total (Adjusted)

The sum of the squared Y values minus the mean sum of squares.

Mean Square
The sum of squares divided by the degrees of freedom. The Mean Square for Error is an estimate of the
underlying variation in the data.

Asymptotic Correlation Matrix of Parameters
Asymptotic Correlation Matrix of Parameters
A0
A1
A2
A0
1.000000
-0.668342
0.251252
A1
-0.668342
1.000000
-0.826039
A2
0.251252
-0.826039
1.000000
A3
-0.126446
0.725516
-0.986996
B1
0.045937
0.586512
-0.937223
B2
0.033491
-0.664699
0.967391
B3
-0.444426
-0.127771
0.655601
B4
0.769239
-0.364811
0.217490
B3
B4
A0
-0.444426
0.769239
A1
-0.127771
-0.364811
A2
0.655601
0.217490
A3
-0.765633
-0.176658
B1
-0.867018
-0.095811
B2
0.801153
0.123138
B3
1.000000
-0.139159
B4
-0.139159
1.000000

A3
-0.126446
0.725516
-0.986996
1.000000
0.978499
-0.991658
-0.765633
-0.176658

B1
0.045937
0.586512
-0.937223
0.978499
1.000000
-0.989097
-0.867018
-0.095811

B2
0.033491
-0.664699
0.967391
-0.991658
-0.989097
1.000000
0.801153
0.123138

This report displays the asymptotic correlations of the parameter estimates. When these correlations are high
(absolute value greater than 0.95), the precision of the parameter estimates is suspect.

Predicted Values and Residuals Section
Predicted Values and Residuals Section
Row
No.
1
2
3
4
.
.
.

X
10.69182
12.26415
13.83648
15.4088
.
.
.

Y
21.76471
26.47059
31.17647
35.88235
.
.
.

Predicted
Value
23.39933
26.25687
29.50871
33.16126
.
.
.

Lower 95.0%
Value
20.2282
23.30506
26.70471
30.38701
.
.
.

Upper 95.0%
Value
26.57045
29.20868
32.31271
35.93551

Residual
-1.634617
0.2137172
1.667763
2.721093

The section shows the values of the residuals and predicted values. If you have observations in which the independent
variable is given, but the dependent (Y) variable was left blank, a predicted value and prediction limits will be
generated and displayed in this report.
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Residual Plots

Function Plot
This plot displays the data along with the estimated function and prediction limits. It is useful in deciding if the fit
is adequate and the prediction limits are appropriate.
In poorly fit models, we have found that it is often necessary to disable the prediction limits so that the data will
show up. In these cases, the prediction limits may be so wide that the scale of the plot does not allow the data
values to be separated.
Residual versus X Plot
This is a scatter plot of the residuals versus the independent variable, X. The preferred pattern is a rectangular
shape or point cloud. Any nonrandom pattern may require a redefining of the model.
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In this example, it appears that the variance of the residuals decreases as X increases—suggesting that the equal
variance assumption is violated. If this pattern was very drastic, we might want to try a variance stabilizing
transformation of Y or using weighted nonlinear regression. However, the pattern does not appear severe in this
case, so we probably would not take further action.
Normal Probability Plot
If the residuals are normally distributed, the data points of the normal probability plot will fall along a straight
line. Major deviations from this ideal picture reflect departures from normality. Stragglers at either end of the
normal probability plot indicate outliers, curvature at both ends of the plot indicates long or short distributional
tails, convex or concave curvature indicates a lack of symmetry, and gaps or plateaus or segmentation in the
normal probability plot may require a closer examination of the data or model. We do not recommend that you
use this diagnostic with small sample sizes.

Predicting for New Values
You can use your model to predict Y for new values of X. Here’s how. Add new rows to the bottom of your
database containing the values of the independent variable that you want to create predictions for. Leave the
dependent variable blank. When the program analyzes your data, it will skip these rows during the estimation
phase, but it will generate predicted values for all rows, regardless of whether the Y variable is missing or not.
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